
What is the Internet? 

 The Internet is a global electronic system of networks which connects 

computers around the world. Many people think of the Internet and the  

World Wide Web (WWW) as one and the same thing. This is a misconception.  

Although the World Wide Web is probably the most widely used resource, it is 

only one of many resources available on the Internet. 
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      Servers:  

  Computers 

  that host (store)   

  resources accessible 

   by using the Internet 

User(Client) 

   Modem:  

A device, either internal 

or external, which connects 

the user to their ISP (Internet 

Service Provider), which in turn 

connects the user to the Internet  

Router: A device which forward 

data packets along networks. 

Packet: Piece of 

message transmitted 

over a Network 



Examples of resources available on the Internet: 
 

1) World Wide Web (WWW) – Consists of Web sites.  

2) Email – At one time email was a type of communication available on the 

 Internet but completely separate from the WWW. Now there are so many  

 Web sites offering  email, it is no longer always a separate resource. 

3) IRC (Internet Relay Chat) – Chat rooms allow real-time communication. 

 Accessing chat rooms is not allowed on library computers. 

4) Listservs – Email newsletter, each devoted to a certain topic. 

 Somewhat like a magazine subscription. Subscription is usually free. 

5) Usenet – Made up of newsgroups, also known as discussion groups or 

 bulletin boards. Messages (questions, answers, comments) devoted to 

 a certain topic can be posted and/or viewed without personal registration. 

Accessing the Internet using a computer requires: 

 1) Modem – A device, either internal or external, that allows the computer to 

 transmit and receive data. 

2) ISP (Internet Service Provider) – A company that provides access to the 

 Internet. 

3) Browser – A computer program designed, at its most basic level, to locate 

 and display data residing on the Internet. 

  Two commonly used browsers are: 

   Internet Explorer  (IE) 

   Netscape Navigator 

Examples of ways to be connected to the Internet: 

 1) Dial Up – Uses phone lines and the modem inside computers to connect to 

 the Internet. You cannot be actively using the Internet and also using your 

 phone at the same time. It is the slowest type of connection. 

2) DSL (Digital Subscriber Line) – Uses phone lines, but piggy-backs the 

 signals on the lines so that one part of your phone line is dedicated to your 

 Internet connection and the other part of your line is dedicated to your 

 phone. You can be actively using the Internet and your phone at the 

 same time. It is much faster than Dial Up and more stable (you rarely get 

 disconnected during an Internet session as happens with Dial Up), but 

 you cannot use the modem in your computer; you must obtain one. 

3) Cable – Uses a cable just the same as cable television. You must obtain a 

 modem from your ISP. Comparable to DSL in features. 

4) Satellite – A connection using a satellite. Outdoor and indoor equipment 

 must be obtained. Actually, a satellite connection is slower than DSL or 

 Cable and about twice as expensive. 

5) Wireless – Using a properly equipped laptop computer, Pocket PC or even a 

 cell phone, the Internet can be accessed using a wireless connection.

 You must also have a wireless Internet access plan, the proper software 

 and be within range of a “hot spot”, which is a location that has the 

 equipment to broadcast, so-to-speak, data from the Internet. 
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 The World Wide Web (WWW)  

 

The World Wide Web consists of Web sites. 

  

Web site: 

 Like books, Web sites contain information and consist of pages. 

 A Web site may consist of many pages or just a single page.  

  

Web page: 

 The individual pages that make up a Web site. You view a single Web 

page at a time. 
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Home page: 

When accessing a Web 

site, the first page 

displayed is usually 

the Home page. Often, 

like a book’s table of 

contents, it gives 

information about 

what is available on 

that site. Your browser 

also has what is 

referred to as “your 

home page.” This is 

simply the first page 

displayed when you 

connect to the 

Internet, or, the 

starting point of your 

Internet session. 

Jefferson Parish Library Home Page 



Hyperlinks/Links 

One way to navigate the WWW is by clicking on a link. A link is an area of a Web 

page that, when you click on it, will take you from the page you are presently viewing 

to another page either within the same site or to an entirely different site.  

 Links can be anything on a page. Examples: 

•  Underlined text; color varies but is often blue 

•  Images 

•  Objects in motion 
 

Any of the following may happen when you point to a link: 

•  The mouse arrow should change into hand with pointing finger 

•  Address appears on Status Bar 

•  Link changes colors 

•  Link moves 

•  Box appears near link with a Web page address or information 

FEATURES of a Web PAGE 

Name and Address 

Web pages have names, displayed on the Title Bar, and addresses or URLs (Uniform 

Resource Locator), displayed in the Address Bar. When you hear, “Visit our Web site 

at www.whatever,” this is the address of the Web site.  

 Below is the Home Page of Jefferson Parish Library’s Web Site 

 
 

Address or URL 

of page currently being viewed 

appears in 

Address Bar 

Links 

When pointing to a link 

the Status Bar displays 

address of Web page 

that clicking on link 

will take you to 

Mouse pointer 

changes into 

hand when 

pointing to link 

Once you have clicked on a link it may change colors. Many Web pages have this 

feature which can be helpful in retracing steps taken in a Web search.  
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Title Bar 

Navigational Bar 



5 

FEATURES of INTERNET EXPLORER 

Title Bar 
Menu 

Bar 

Address 

Bar 

Status 

Bar 

Minimize, Resize, Close 

Title Bar: Displays the name of the Web page you are viewing and which program you 

 are using. It also contains the minimize, resize, & close (exit) buttons. 

 

Menu Bar: Contains buttons which open drop-down menus that provide access to 

 most commands available in the program. In most Windows programs, the most 

 common menu options are File, Edit, View and Tools. 

 Example 1: Clicking on File > Print Preview will show you what the Web page will look 

 like if printed and exactly how many pages it will take to print the Web page.  

 Example 2: Clicking on Edit > Find (on This Page) will allow searching for all 

 occurrences of a word or phrase on a page. To use the Find feature:  

   In the Find window: 

    Enter word or phrase in the Find what field 

    Make sure the correct Direction is chosen (Up or 

Down)     

  Note: Find searches in one direction only,  

      starting from 

your position on the page 

    Click on Find Next 

 Another way to access the Find feature is by holding down the Ctrl key on the 

 keyboard and pressing the F key (Ctrl+F). 

Toolbar 

Program Tabs 
Toolbar 



Standard Toolbar 

Back                  Forward 

With these buttons you can return to pages you have visited: 

 1) only during the same session you are presently in 

 2) in the exact order you have visited them 

If a button is grayed out, it is unavailable, which means that it is impossible to 

perform this function at this time. For example, if the Forward button is grayed 

out, this means that you have not visited any pages beyond this point. If you 

click the Back button and move back to the previous page, the Forward button 

then becomes active because you have taken a step back, so to speak, and, 

therefore, can move forward to the page from which you have stepped back. 

Stop 

When you are trying to access a Web page, if you click the Stop button before the 

page is displayed, the browser will stop trying to access the page and return to 

the page you were viewing. 

 Reasons to use the Stop button: 

  1) you clicked on a link by mistake 

  2) it is taking much too long to connect to a Web page 

  3) you are taken to a page with the message “page cannot be displayed” 

      (the connection may be successful on the second attempt) 

Refresh  

This button breaks the connection with the page you are viewing, then reconnects 

to the same page giving you the latest version of that page. In other words, it 

updates the page you are viewing if any changes have occurred on that page. 

 Reasons to use the Refresh button: 

  1) When viewing pages which contain information such as, the stock 

      market, sports scores, weather or breaking news. Many sites do not 

      automatically update information while you are viewing a Web page.

  2) Back & Forward buttons do not refresh the pages to which they take 

      you. Pages are displayed exactly as they were when you first 

      accessed them. If it is possible that any information may have 

      changed since last you have visited the page (in the same session), 

      click Refresh once the page is displayed. 
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Home 

This button takes you back to the first page that is set to display when you connect 

to the Internet—your starting point. You can change your Home. The easiest way is 

to, first, go to the page you want as your new starting point or new Home. Using 

the Menu Bar click on the following: 

  Tools > Internet Options > General Tab 

There will be a small address bar displaying the address of your present Home. 

Click on the Use Current button beneath that address bar and the address will 

change to the page you are viewing. Click on OK. You may also type into this same 

address bar the Web address of any page that you would like to be your Home. 

Favorites 

While exploring the Internet, you will find many pages which you will want to revisit 

in the future. The Favorites button offers a way to return to those pages quickly 

and easily without having to remember their addresses or how you found them. 

Favorites remain listed for use during your present session or future sessions 

The Favorites menu opens up on the left 

side of the screen. This menu lists all the  

web sites that have saved into the 

favorites menu. Selecting a web site from 

this menu will send the browser to that 

site and close the menu. You can exit the 

menu without selecting a web site by 

clicking the Favorites button again. 

The page which you are presently 

viewing remains open. The menu 

opens on top of the current page. 

Once you click the Favorites button on the Standard toolbar the following occurs: 



Adding Favorites 

To add a page to the Favorites, you must first be viewing that page. Once you 

  are at the page, click Add to Favorites button and select “Add to Favorites” 

from the menu…   The Add Favorite window opens. 

      Click ADD. 
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Once a page is listed in the Favorites, if, at any time in the future, you wish to visit  

that page, simply move the mouse pointer underneath where that page is listed. 

The arrow will turn into a hand with a pointing finger and the page name (or Web 

address) will become underlined. Also, a box may open with information about 

the page. A single left click  should take you  to that page, displaying it in the 

right section of your screen. To close the Favorites menu, click on the Favorites 

button again. 



History  

On the left side of the address bar, there is a drop down arrow. Point to the drop 

down arrow and left click. You will get a list of sites you have visited. See below. 

Click on any of the links and you will go to the most recently visited sites.  
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Clicking on the History tab at the bottom of the drop down menu (above) will 

bring up the menu below where you can view your sites visited less recently. 



On your own computer you can 

determine how long you wish for the 

history to keep a list of pages visited. 

On the Menu bar click Tools. Click 

Internet Options on the Tools menu. 

The box to the left will open. Near the 

top will be tabs. The General tab 

should already be selected. If not, click 

on it. 

In the Browsing History section near 

the middle, clicking the Settings 

button will open a window where you 

can set the number of days the History 

with retain viewed pages.  (Below) You 

can also choose to delete your 

browsing history by clicking the 

‘delete’ button . (Right) 

Internet Options, Setting History 

Once you are finished, click OK. 
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Print Preview  

This button will show you exactly what the web page(s) will look like if printed, 

how many pages it will take to print and exactly what is on each printed page. 

Below is an example of what clicking Print Preview will display. To return to the 

normal view click on the X on the extreme right of the Title Bar. 

     If the print is too 

  large or too small 

  for you viewing,  

  you can change 

  the size. The size 

  change will also  

  show up on  

  the printed page. 

Print  

A quick way to 

access the 

printing 

options. 

Text Size 



Address Bar 

If you know the address of a web site, such as www.yahoo.com, you can go 

directly there by typing the address in the Address Bar located just below the 

Standard Toolbar. 

Address Bar 
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If you click inside the Address Bar, the address becomes highlighted. At this 

point you can simply type in a new address. You do not have to do anything 

to erase the present address. Whatever is highlighted will be automatically 

erased with your first keystroke and replaced with what you type. Then click 

the Enter key on the keyboard or click the GO button to the right of the address 

bar. When you type an address into the address bar, the Refresh button 

changes into the GO button. 

Drop-down arrow: 

Located at right end of the Address Bar keeps the addresses of the sites you 

have typed into the Address Bar. When you click on the arrow, it opens a 

drop-down menu and allows you to return to a site simply by clicking on the 

site in the drop-down menu. 

http://www.yahoo.com/
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Tips for entering addresses: 

1) No spaces in web address 

2) Use lower case letters unless upper case is specifically noted 

3) Accuracy is important. The address must be exactly correct. Any 

 deviation will not get you to the correct page 

4) With newer browsers you do not have to type http:// 

5) If the address begins with ftp:// you must type in the 

 complete address including ftp:// 

 

 

Things you should know about web address domains: 

The domain consists of letters in the address, often at the end and always after 

a dot (period), which tells you what kind of Web site it is. Examples: 

1) .com = commercial 

2) .edu = educational institution 

3) .gov = government site 

4) .mil = military 

5) .org = non-profit organization and certain other types of organizations  

6) .la.us = site from an official Louisiana institutions such as the libraries 

 

There are many more domains. Other countries have their system of domains. 



SEARCH ENGINES (SE’s) 

SE’s are Web sites whose main purpose is to find sites which contain information 

that you are interested in finding if you do not know a specific address. 

Although different SE’s will very often return lists containing many of the 

same sites, they will also return different sites in addition to the duplicates. 

If you do not know a web address, you can search by typing terms in a 

search box. True SE’s use electronic devices called robots or spiders (they 

run around the Internet, including the World Wide Web searching).  

Many SE’s have different methods of searching and search different sections of 

Web pages for your term(s): 

 --some search the Web pages’ titles 

 --some search the URL 

 --some search the entire text of the web page 

Most SE’s have become quite sophisticated in interpreting how you enter multiple 

terms into the search box so the page following this one may not be 

necessary with some search engines. It is always very helpful and you will 

learn a great deal about searching by checking the help option or search tips 

for the search engines you are using. It is well worth your time. 

The Search Text Box is the area where topics or search terms are entered. Always 

check to see that the blinking insertion point is in this area. If not, point 

inside the text box, click, move the mouse away, check to see that the 

blinking insertion point is now present in the text box, and type in the 

topic(s) on wish you want to find information. 

Enter a search term(s); click that site’s Search button or press the Enter key. 

The SE will process your search request and create a Results/Hits list of sites. 

Types of Search Engines 

There are different types of search engines: 

1) Directory 

 Yahoo is an example of a directory search engine. 

 At Yahoo, actual people examine sites for content, then categorize and place 

them into a directory which is navigated by links. Web sites found in the 

directory almost assuredly contain information on the topic under which 

they are placed.  

2) Multi- or Meta-Search engines 

 ixquick is an example of a Meta- or Multi-Search engine. 

 These web sites employ more than one individual SE to find your term(s). 

 Below is the address of a site to help you evaluate certain search engines: 

www.infopeople.org Point to Search Tools; click on Search Tools Chart. 
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http://www.infopeople.org/


Addresses of sample Search Engines, Multi/Meta-Search 

Engines and Directories  

Multi/Meta-Search Engines: 

 ixquick – www.ixquick.com 

 Google –www.google.com 

 Ask Jeeves – www.askjeeves.com 

 Dogpile – www.dogpile.com 

 FAST Search – www.alltheweb.com 

 Mamma – www.mamma.com 

 Metacrawler – www.metacrawler.com 

Search Engines: 

 AltaVista – www.altavista.com 

 Excite – my.excite.com/myexcite/my.jsp 

 HotBot – www.hotbot.com 

 Infoseek – infoseek.go.com 

 Lycos – www.lycos.com 

Directories: 

 Yahoo! – www.yahoo.com 

Other Web Sites of Interest 

Libraries: 

 Jefferson Parish Library – www.jefferson.lib.la.us 

 Library of Congress – www.loc.gov 

 Salt Lake City Public Library – www.slcpl.lib.ut.us 

Tutorials:  

 Excel Tutorial – www.usd.edu/trio/tut/excel 

 Word Tutorial- www.baycongroup.com/wlesson0.htm 

Automobiles: N.A.D.A. – www.nada.com 

Employment: Monster – www.monster.com 

Entertainment: Internet Movie Database – www.imdb.com 

Health: healthAtoZ – www.healthatoz.com 

How Do Things Work: www.howstuffworks.com 

 

Louisiana: INFO Louisiana – www.state.la.us 

Maps: Mapquest – www.mapquest.com 

News: CNN – www.cnn.com 

Sports: ESPN – www.espn.go.com 

Weather: Weather Channel – www.weather.com 
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python 

monty 
pytho

n 

Search Techniques 

1) Rules vary from one SE to another - Always take time to check each SE’s search 

tips, Help, etc. 

2) Lowercase - Always enter terms in lowercase. If you capitalize, the SE may 

retrieve the term only if it is capitalized on the web page. With proper names, 

only capitalize the initial letters. 

3) Phrases - Enclose a phrase in quotes so that it is treated as a phrase and not as 

individual words. 

4) Use unique or specific words -Avoid general or broad terms; Spelling counts! 

5) Boolean or Logical Operators – help fine tune search results. 

 

apple 

 

computer 

AND     + 

Example:  apple AND computer 

   apple  +computer 

[Note: Do not put a space between + and the 

word which follows.] 

Search will return only those pages which 

contain both terms. 

Search results: Only the overlapping area of 

the two circles at left.  

 

college 

 

 university OR 

Example: college OR university 

Search will return pages which 

contain either term. 

Search results: The entire area of 

both circles at left. 

NOT   - 

Example: python NOT monty 

      python  –monty 

[Note: Do not put a space between - and 

the word which follows.] 

Search will return all pages with the 

term except the ones excluded. 

Search results: The area contained 

within the larger circle except that 

contained in the smaller circle within. 
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INTERNET GLOSSARY  

BOOLEAN SEARCH - A search using words AND, OR, and NOT. The words are 

used to increase or decrease the amount of information you may get when 

doing a search. George Boole developed the process. 

BROWSER - A program on a computer that accepts requests for information, 

processes the requests and allows you to navigate to resources on the 

Internet. Microsoft Internet Explorer is the browser used in the Jefferson 

Parish Library System computers. Netscape is another popular browser. 

BLOG- (WEBLOG) An online journal made up of links and postings in reverse 

chronological order. Many blogs link to other web pages, allowing readers to 

participate in discussion of information on certain blogs. You must register on 

the blog site to participate  

DOWNLOAD - When you copy a file from another computer to your computer 

such as when using FTP (File Transfer Protocol-a program to download files) 

to get software and files. 

E-MAIL - Stands for electronic mail. It involves sending and receiving messages 

over a network such as the Internet.  

HOST - A computer that provides information to internet users. Also known as 

a server. 

HTML - (Hypertext Markup Language) One of the computer languages used to 

create web pages. 

HTTP - (Hypertext Transfer Protocol) The Internet standard for transferring 

information on the World Wide Web. 

HYPERLINK - (Also known as a link) A connection from one World Wide Web 

document to another. Clicking a link transfers to the destination document. 

INTERNET - A worldwide computer network that connects universities, 

government laboratories, companies, and individuals around the world. The 

Internet provides data communication services such as electronic mail, file 

transfer, discussion groups, and remote log-on to distant computers. 

ISP - (Internet Service Provider) The Company you use to connect to the 

Internet, usually for a monthly charge. 

MY SPACE- a social networking website offering interactive, user submitted 

network of friends, personal profiles, blogs, groups, photos, music, and videos 

internationally. 

PROTOCOL - A set of rules or standards that must be followed to enable 

communication or file transfers between two computers. Without such 

standards, the two computers would not be able to communicate with each 

other. 
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SEARCH ENGINES - Web sites that index hundreds of thousands of web pages, 

and allow you to search through them by keyword to find topics you are 

interested in. Some of the major search engines include Yahoo!, AltaVista, 

Lycos, Webcrawler, and Google. 

URL - Uniform Resource Locator is the address for the web sites. An example of 

a URL is http://www.jefferson.lib.la.us. Many browsers will add the http:// for 

you.  

WEB PAGE - A World Wide Web page. A web page may print out several paper 

pages. A web site is a collection of web pages with some common ownership or 

theme. A home page is the front door for the web site - the page you usually 

see first when you connect to the site. It typically indicates a web site’s 

ownership, purpose and contents. The home page also provides links to 

important pages within the site. 

WORLD WIDE WEB - Known as WWW or the Web. This resource is a major 

component of the larger Internet. It allows users to explore and retrieve text 

and graphics from web sites. 
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Notes 

Jefferson Parish Library authorizes you to view and download materials such as this handout at our web site 
(www.jefferson.lib.la.us) only for your personal, non-commercial use, provided that you retain all copyright 
and other proprietary notices contained in the original materials on all copies of the materials. You may not 
modify the materials at this site in any way or reproduce, publicly display, perform, distribute or otherwise 
use them for any public or commercial purpose. The materials at this site are copyrighted and any 
unauthorized use of any materials at this site may violate copyright, trademark, and other laws. If you breach 
any of these Terms, your authorization to use any materials available at this site automatically terminates and 
you must immediately destroy any such downloaded or printed materials. 
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